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Welcome to PowerShell HelpWriter

1 Welcome to PowerShell HelpWriter

Writing and editing Windows PowerShell help files has never been easier!

PowerShell HelpWriter is the premier editor for creating and editing help files for all

command types, including cmdlets, functions, workflows, and CIM commands. Fo-

cus on your content and let PowerShell HelpWriter handle the XML! 

For a complete list of current features, visit the PowerShell HelpWriter product page.

About this documentation

This help is designed to show you how to use PowerShell HelpWriter—you can do a quick overview

to get started, work through the topics in detail, and refer back to this guide for additional informa-

tion when needed.

Getting started - new users

· Download and install PowerShell HelpWriter.

· Quickly learn the basics of the program in Getting Started .

· Visit the support forum to get help from SAPIEN staff and other experienced PowerShell

HelpWriter users.

12

https://www.sapien.com/software/powershell_helpwriter
https://www.sapien.com/software/powershell_helpwriter
https://www.sapien.com/forums/viewforum.php?f=28
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2 Introduction

This section provides an overview of the PowerShell HelpWriter features, lets you know how to get an-

swers to your questions, and shows you how to purchase directly online or through a reseller.

2.1 About PowerShell HelpWriter

PowerShell HelpWriter is the first professionally designed environment for writing and editing Windows

PowerShell help files. This section provides an overview of the features and benefits of PowerShell

HelpWriter.

What is PowerShell HelpWriter?

PowerShell HelpWriter is the premier editor for Windows PowerShell XML help files.

· Create help files quickly and easily for a module or from scratch, or edit existing help files.

· The PowerShell HelpWriter Designer provides a studio environment for writing and editing help

with the resource you need close at hand, including syntax displays, a built-in XML editor, and

quick navigation.

· PowerShell HelpWriter can generate help for all commands in a modules. The help files match the

code, including cmdlet attributes, parameters and parameter attributes, inputs and outputs, and

even an optional online help link. And, your files can include any help you have already written, in-

cluding comment-based help, so no effort is ever wasted. 

· PowerShell HelpWriter works with the simplest and most complex modules, including modules

with nested modules, and names them correctly so Get-Help can find them. It works on all sup-

ported command types—cmdlets, functions, workflows, and CIM commands.

· Your help files are ready to go. You can ship the help files in your module, use them in Updatable

Help, and share them in an open source project with no post-processing. 

Work in a Help Designer

Tired of typing XML in Notepad or settling for comment-based help? Welcome to the PowerShell

HelpWriter Designer, a professional studio for writing and editing help topics. You don't need any

expertise in XML and you don't  need to learn the complex structure of the Windows PowerShell

Help XML schema.
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Edit in XML

Whenever you need it, you can view or edit the help file in the built-in XML editor. To view the under-

lining XML., click the Edit in XML button. The PowerShell HelpWriter XML editor is a complete XML

editor—not just a read-only viewer. 

Want to switch back? Click Edit in Designer. 

For more information, see Edit Help Topics as XML .67
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Generate starter files for any module

No need to start from scratch. PowerShell HelpWriter analyses your module and generates starter

help files that match the cmdlet code. 

It implements the naming rules that allow the Get-Help cmdlet to find your help file.
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The starter files include cmdlet attributes, parameters and parameter attributes, input and output

types, and even an online help link for commands that support online help, so you can focus on

writing descriptions.

  If the code changes, you can add and remove parameters from your help topic.
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Focus on examples

The PowerShell HelpWriter designer features an environment especially designed for writing ex-

amples with an editable prompt and monospace font for formatting output. 

For more information, see Write Examples in Help .

Get the details right

PowerShell HelpWriter makes it easy to include even detailed information for advanced readers.

For more information, see Write Help for Inputs , Write Help for Outputs , Write Notes in

Help , and Add Related Links .

47

53 58

61 64
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Test in Get-Help

You can test your help files as you work, validate them, and run them in Windows PowerShell.
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Product Updates

You can learn about product updates on our blog and in the release build log, and you can also

submit product feedback and suggestions.

· Check out the PowerShell HelpWriter articles on the SAPIEN blog.

· View the PowerShell HelpWriter version history.

· Submit feedback and suggestions.

2.2 How to Buy PowerShell HelpWriter

You can buy PowerShell HelpWriter online with all major credit cards. As soon as your transaction com-

pletes you can download and install the program.

For answers to your pre-order questions, check out the SAPIEN Frequently Asked Questions or post in

the Trial Software / Pre-sales Technical Questions forum.

https://www.sapien.com/blog/topics/topics/powershell-helpwriter/
https://www.sapien.com/software/version_history/PowerShell_HelpWriter_2024
https://www.sapien.com/requests/product_requests/7
https://www.sapien.com/support/faqs
https://www.sapien.com/forums/viewforum.php?f=8
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Order link and PowerShell HelpWriter product page

Online orders:

https://www.sapien.com/store/powershell-helpwriter

Worldwide authorized resellers:

https://www.sapien.com/company/resellers

PowerShell HelpWriter product page:

https://www.sapien.com/software/powershell_helpwriter

https://www.sapien.com/store/powershell-helpwriter
https://www.sapien.com/company/resellers
https://www.sapien.com/software/powershell_helpwriter
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3 Getting Started

This section shows you how to install PowerShell HelpWriter and keep it up-to-date.

3.1 Installing PowerShell HelpWriter

To get started using PowerShell HelpWriter, follow the instructions below to download and install the

program.

Downloading PowerShell HelpWriter

All SAPIEN Technologies software products are downloadable only. Download registered products

from your SAPIEN Account Registered Products page. 

Select the 64-bit version of PowerShell HelpWriter to download. The installer software will save to

your default download folder (e.g., PHW24Setup_3.0.65_010524_x64.exe).

  Starting with the PowerShell HelpWriter 2020 product release, 32-bit versions are no longer

available. Current owners of a license that includes a 32-bit product will have access to that from

their SAPIEN Account Registered Products page. 

Want to try before you buy? You can download a trial version here.

Installing PowerShell HelpWriter

Follow these instructions to install PowerShell HelpWriter.

How to install PowerShell HelpWriter

1. In your default download folder, double-click on the downloaded program (e.g.,

PHW24Setup_3.0.65_010524_x64.exe). 

2. Reply Yes to the "Do you want to allow this app to make changes to your device?" prompt.

The installation wizard will first check several items, such as available disk space and the presence

of previous builds. If the environment is adequate, the installer will display the legal agreement

which you must accept to proceed:

a. Read the terms of the license agreement. 

b. Accept the terms of the license agreement. You should never accept license terms unless you

have read them, and you understand them.

c. Once you have accepted the terms, click Install.

  The software will install in the default location as shown, unless you change the path.

https://www.sapien.com/account/products
https://www.sapien.com/account/products
https://www.sapien.com/software/powershell_helpwriter
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3. The installation may take several minutes. 
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4. When PowerShell HelpWriter successfully completes the installation, click Finish. 
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Troubleshooting Installation

If you encounter problems installing PowerShell HelpWriter, please report them in the Installation Is-

sues support forum.

Activating and Deactivating PowerShell HelpWriter

Software activations are outlined in our End-User License Agreement. The number of activations al-

lowed will differ depending on your type of license. For Perpetual Licenses, each licensed user is al-

lowed to have a maximum of two devices activated and operating at any given time for personal

use. For Subscriptions*, each licensed user is allowed to have the software activated on a total of 20

devices with a maximum of two devices operating simultaneously at any given time for personal

use.

Product Activation

Registration is required to activate and operate the product, and also to obtain any customer service

https://www.sapien.com/forums/viewforum.php?f=29
https://www.sapien.com/forums/viewforum.php?f=29
https://www.sapien.com/company/eula
https://info.sapien.com/index.php/quickguides/sapien-software-subscriptions#UsingSubscription
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or technical support benefits. Registration only takes a few moments to complete and provides you

with access to special offers including preferred pricing on renewals. You will need an active internet

connection to complete product registration.

An active internet connection may not be required if you have a legitimate reason for needing offline

access. To request offline activation please fill out this request. All requests are considered on a case-

by-case basis. Please note: Activation keys belonging to Subscriptions* are not eligible for Offline

Activation.

* Information about software activations for Subscriptions only applies to SAPIEN Technologies

products with a Subscription purchase offer.

To activate PowerShell HelpWriter

The first time you launch a SAPIEN product, the Welcome screen is displayed.

The steps to activate the product vary depending on whether or not you already have a SAPIEN ac-

count. 

  Follow the steps in the Quick Guide to SAPIEN Software Activation to activate the software.

If you are unable to activate the product, contact sales@sapien.com.

Product Deactivation

Removing a software activation, also known as "deactivating", allows you to free up an activation for

use on another device.

https://info.sapien.com/index.php/quickguides/offline-license-file-replaces-offline-license-key
https://info.sapien.com/index.php/quickguides/offline-license-file-replaces-offline-license-key
https://www.sapien.com/account/requestkey
https://info.sapien.com/index.php/quickguides/sapien-software-subscriptions#UsingSubscription
https://info.sapien.com/index.php/quickguides/quick-guide-to-sapien-software-activation
mailto:sales@sapien.com?Subject=Activation%20Support
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You may deactivate your devices to free up your activations at your leisure, but there are certain cir-

cumstances where proper deactivation is crucial to prevent the loss of your allotted activations . 

  Uninstalling the software from your device does not deactivate the activation key. 

To deactivate your activation key

In the top-right of PowerShell HelpWriter above the ribbon, click the Activation Information button.

The Activation Information window will open.

  Follow the steps in the SAPIEN Software Activation / Deactivation FAQ to deactivate your activa-

tion key.

3.2 Staying Up-to-date

We are continually updating PowerShell HelpWriter, both to remove bugs and to add and improve

product features. We recommend always staying current with the most recent version to ensure that you

are taking advantage of the latest features, functionality, and product stability.

  The details for every PowerShell HelpWriter release are available in the version history.

Check for Updates

By default, PowerShell HelpWriter will automatically check for software updates. You can also manu-

ally check for updates.

To check for updates

· On the Help ribbon (Updates section) > click Check For Updates to open the SAPIEN Updates

tool and see if there is a new PowerShell HelpWriter build available:

15

74

https://info.sapien.com/index.php/quickguides/sapien-software-activation-deactivation-faq
https://www.sapien.com/software/version_history/PowerShell_HelpWriter_2024
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4 Basic Orientation

This section shows you how to easily customize your workspace, and provides a basic orientation to

PowerShell HelpWriter by walking through the steps to create a help file from a module. The topics are

presented in the order that you would perform the tasks, but you can easily jump to any topic and work

your way through..

4.1 Customizing Your Workspace

You can adjust the appearance and behavior of PowerShell HelpWriter to meet your needs.

Change the Color Style

To change the color themed style

· In the upper right corner, click Style and then select a style name. 

Your changes are saved automatically and persist after closing.

Show or Hide the Start Page

The PowerShell HelpWriter Start page opens when you start PowerShell HelpWriter. It lists recently

used files, references for help, and topics of interest. If you close it, it remains closed until you start

PowerShell HelpWriter again.

The Show start page on startup option (on the Start Page) determines whether the start page

opens whenever you start PowerShell HelpWriter.

To Show / Hide the Start Page

To prevent the Start Page from opening when you start PowerShell HelpWriter:

1. On the Home tab > in the Windows section, click Options. 
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2. Click to clear the Show start page on startup option. 

Your changes are saved automatically when you click outside of the Options window.

  To restore the Start page, select the Show start page on startup check box.

Change the Font

You can change the font, style, or size of the text in the Designer input fields and XML Editor. A

single setting determines the fonts for both displays.

The default font is Consolas, 10 pt., Regular

To change the font

1. On the Home tab > in the Windows section, click Options. 

2. On the Options page > in the Default Font section, click the ellipsis (...). 

  Editing the value in the text box doesn't change the font—it's just a display.
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3. Adjust the settings in the Font dialog box. 

Change the Default Directory

Typically, you save your help files where the Get-Help cmdlet looks for them, that is, in a language-

specific subdirectory of the module directory, such as $home\Documents\Modules\<mod-

uleName>\en-US. This location lets you use Get-Help to test your help file as you write it. However,

you might decide to keep your draft help files in a separate directory.

When you save each help file for the first time, PowerShell HelpWriter suggests the default directory.

Thereafter, it suggests the directory most recently used to save that help file.

The default location is: 

$home\Documents\SAPIEN\Help Files 

(%UserProfile%\Documents\SAPIEN\Help Files).
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To change the default directory

1. On the Home tab > in the Windows section, click Options. 

2. In the Default Directory section > type a new path or click the ellipsis (...) and navigate to the new

path. 

3. Restart PowerShell HelpWriter to make the change effective. 

4.2 Create a Help File for a Module

This is the first step in a set of instructions designed to help you quickly get started using PowerShell

HelpWriter by demonstrating how to create a new help file from a module. The steps to review, write,

edit, test, and ship the file are included.

To create a new help file from a module

1. Click File > New > New Help File (From Module) (Ctrl+N): 

2. Select a module: 
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The Select Module window lists all modules in all paths in your PSModulePath environment vari-

able. It shows how many commands the module exports and lets you include or exclude existing

help sources, including comment-based help.

3. Save the help file for the module: 

By default, PowerShell HelpWriter saves your files in the most recently used location. 

  For easy testing with the Get-Help cmdlet, save the help file where Get-Help looks for it; that

is, in a language-specific subdirectory of the module directory. 
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To change the default file location

1. On the Home ribbon > in the Window section > click Options. 

2. In the Directories section, click the ellipsis (...), then navigate to the desired location and click

Select Folder.

If your module has nested modules, PowerShell HelpWriter creates a separate help file for the cmd-

lets that are defined in each nested module and saves them in the same location.

  To use an XML help file for a Windows PowerShell function, the function must have an Extern-

alHelp comment keyword. For more information, see about_Comment_Based_Help.

4.2.1 Review the Starter Help

After you create a new help file from a module , you can open the new starter help file and review the

fields in the designer.

To see the command syntax

· In the tree navigation, click a parameter set. There will be one parameter set element for each para-

meter set in the cmdlet. 

  The parameter nodes under each parameter set determines the contents of the syntax dia-

gram. The attribute values are specific to each parameter set, but the descriptive fields are shared

by all instances of the parameter in the help topic.

21

http://go.microsoft.com/fwlink/?LinkID=144309
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To see the parameter attributes

· In the All Parameters section of the tree navigation, click the parameter name.

To view the Inputs, Outputs, and Links

· Using the tree navigation, click the Inputs, Outputs, or Links node. 
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To view the XML for the file

· Right-click the tab for the file and click Edit in XML.

-OR-

· On the ribbon, click Edit in XML. 

PowerShell HelpWriter saves any changes that you have made and opens the file in the XML ed-

itor. 

  To return to Designer View, click Edit in Designer.

You can use the PowerShell HelpWriter XML Editor to view or edit any XML or text file. If you open a

file that is not a help file, it opens in XML view automatically.

4.2.2 Write the Help Content

Now it's time to write the help content. You can complete the fields in any order. 

Draft the synopsis and description

Typically, you begin by drafting the synopsis and description. Type the content as you want it to ap-

pear in the Get-Help display. To create a paragraph break, just type it. Avoid tab characters. Instead,

use spaces to indent paragraphs.
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Draft the parameter descriptions

Next, draft the parameter descriptions. 

To edit a parameter description

· In the tree navigation > in the All Parameters section, click the parameter name. 

-OR-

· In the Designer > on the parameter row, click the Edit icon. 

PowerShell HelpWriter pre-populates the parameter attributes from the code in the module, but you

can edit any attribute value. For more information about documenting cmdlet parameters, including

composing the descriptions, see Write Help for Parameters .43
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   The parameter nodes under each parameter sets determine the contents of the syntax diagram.

The attribute values are specific to each parameter set, but the descriptive fields are shared by all in-

stances of the parameter in the help topic.

Draft the examples

Now, work on examples, which are, arguably, the most important element in any help topic. Arrange

the examples in order of complexity, beginning with the simplest commands. For more information

about writing examples, see Write Examples in Help .

To add an example

· On the Home tab, click Add Example. 

47
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You can use the Introduction, Command, and Remarks fields as designed, or type the prompt,

command, and remarks content in the Command field. The Command field is typically used for all

elements in a multiple-step command.

Draft the notes

At this point, you might want to add a sentence or two to the Notes section of the help topic. You

can add anything to the Notes section, but it's particularly useful for contact information,

troubleshooting advice, warnings about particular configurations and corner cases, and versioning.

To add a note

· On the Home tab, click Add Note. For more information about Notes, see Write Notes in Help .

Type the notes as you want them to appear in the Get-Help display. 

  You can create a separate Note item for each note or type all of the notes in a single Note

item.

61
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Add related links

The Related Links section of the file lists the names (and, optionally, the URLs) of related help topics.

You can also use the URL of the first related link to enable support for online help, that is, the Online

parameter of the Get-Help cmdlet.

If you use PowerShell HelpWriter to create a help topic from a module and the existing help for a

command in the module includes an online help link, PowerShell HelpWriter adds the online link to

the starter help topic. You can also add and delete online links and standard related links from help

topics.

To add an online link

· Click the Add Online Link icon.

PowerShell HelpWriter adds the Online version: label. 

To enable the link for your site

· Change the URL value to the location of the online version of this help topic.
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To add a standard related link

· Click the Add Link icon and then type the name of the link.

For more details, see Add Related Links .

Save your work

When you change a PowerShell HelpWriter file (in any view), an asterisk appears on the tab beside

the file name to indicate that there are unsaved changes in the file. 

To save your changes

· Type Ctrl+S

-OR-

· Right-click the tab and click Save > click File > then click Save (or Save As)

-OR-

· Click the Save icon on the Quick Access Toolbar.

4.2.3 Edit a Help File

You can close and reopen your help file at any time. 

To open a help file (regardless of how it was created)

· Click File > and then click Open.

64
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To open a recently used file

· Select it from the Recently Opened files list on the PowerShell HelpWriter Start Page.

-OR-

· Select it from the File tab > Recent Documents.
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If you are working with multiple versions of a file, it's easy to forget which version you are editing. 

To see the fully qualified path to any open file

· Hover over the file tab.

To open the parent folder

· Right-click the tab and then click Open containing folder.

Make any changes you need and test again in the Get-Help display or in PowerShell HelpWriter XML

View.
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4.2.4 Test in Get-Help

When you have a first draft of your help content, use the Get-Help cmdlet to test it. 

Save your help file in the location where Get-Help looks for it, that is, in a language-specific subdir-

ectory of the module directory, such as:

$home\Documents\WindowsPowerShell\Modules\<ModuleName>\en-US

If the help topic is for a function that has an ExternalHelp comment keyword, the help topic name

must match the ExternalHelp keyword value. Otherwise, the help topic name must match the name

of the file in which it is defined, and have a -help.xml file name extension. For example, if a cmdlet is

defined in the Widgets.dll file, the help topic for the cmdlet must be in a Widgets.dll-help.xml file.

For detailed information, see Naming Help Files.

Use the Get-Help cmdlet to display the help topic. For example:

Get-Help -Full <CmdletName>

You can edit your file in PowerShell HelpWriteriter while the console window is open. However, to

make your changes effective in Get-Help output, restart Windows PowerShell. 

https://docs.microsoft.com/en-us/powershell/scripting/developer/module/naming-help-files?view=powershell-7
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4.2.5 Ship your Help File

The help files that you create in PowerShell HelpWriter are ready to ship. 

To ship your help file

· Verify that the help file name is the name that the Get-Help cmdlet expects. For details, see Nam-

ing Help Files. 

To include the help files in your module

· Place them in a language-specific subdirectory of the module directory, such as:

$home\Documents\WindowsPowerShell\Modules\<ModuleName>\en-US

You can also include the help file in an Updatable Help CAB file along with your About topics. For

information about Updatable Help, see Supporting Updatable Help.

https://docs.microsoft.com/en-us/powershell/scripting/developer/module/naming-help-files?view=powershell-7
https://docs.microsoft.com/en-us/powershell/scripting/developer/module/naming-help-files?view=powershell-7
https://docs.microsoft.com/en-us/powershell/scripting/developer/module/supporting-updatable-help?view=powershell-7
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5 Using PowerShell HelpWriter

This section shows you how to create new help topics from a module, and how to create an empty help

topic. Information is also provided on writing the text for your help, adding related links, and editing

help topics in XML.

5.1 Create New Help Topic for a Module

This topic covers the steps to create a new help topic from a module.

You can use PowerShell HelpWriter to create new XML-based help topics for all of the commands

that a module exports. It works with all supported module types and command types, including

commands that are defined in nested modules. 

The result is a set of content-ready XML help topics that contain the command syntax, parameters,

and parameter attributes in the commands. The help files are named for the module in which they

are defined as the Get-Help cmdlet requires, so you can concentrate on the all-important descrip-

tions and examples.

By default, PowerShell HelpWriter begins the new files with any existing help that it finds in the mod-

ules, including comment-based help for functions, but you can choose to exclude existing help.

To create a help file for a module

1. Click File > New > New Help File (From Module) (Ctrl+N). 
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2. Select a module > then click Export. 

  By default, PowerShell HelpWriter includes all help available for the command, including help

in XML files and comment-based help. To omit it, clear the Include existing help descriptions

checkbox. 

3. Save the draft help files in any location. For help on naming and locating files, see Naming Help

Files. 

  The Get-Help cmdlet looks for the help files in a language-specific subdirectory of the mod-

ule directory. For example, if a module is saved in:

C:\Users\User01\Documents\WindowsPowerShell\Modules\<ModuleName>

Get-Help looks for English help files for the module in an en-US subdirectory:

C:\Users\User01\Documents\WindowsPowerShell\Modules\<ModuleName>\en-US\<Mod-

ule>.psm1-help.xml

Get-Help looks for French help files for the module in an fr-FR subdirectory:

C:\Users\User01\Documents\WindowsPowerShell\Modules\<ModuleName>\fr-Fr\<Mod-

ule>.psm1-help.xml

https://docs.microsoft.com/en-us/powershell/scripting/developer/module/naming-help-files?view=powershell-7
https://docs.microsoft.com/en-us/powershell/scripting/developer/module/naming-help-files?view=powershell-7
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Now you are ready to write the text of your help file. You can start with writing help for paramet-

ers .

5.2 Create an Empty Help Topic

This topic covers the steps to create an empty help topic.

Usually, you write the code and then write the help. But, you might need to write help without the

code, either because the code isn't available, or when you are using your help topic as a code spe-

cification. 

Create a blank help file

To create a blank help file

· Click File > New > New Help File (Empty).

43
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Enter the command name

To specify the command name: 

1. In the Tree Navigation, click the New-Cmdlet (top) node. 

2. In the Designer, edit the Command Name value.

  When you change the default (New-Cmdlet) to the name of the command, the top node of

the Tree Navigation changes to the new command name.

Add parameters

When you create a help file without code you need to specify the syntax of the command, including

its parameters. 

To add a parameter

· On the Home tab > click Add Parameter.

-OR- 

· In the Tree Navigation > right click Parameters and then click Add Parameter.
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-OR- 

· In the Designer > in the Parameters section, click the Add Parameter icon.

To add or edit parameter attributes

1. In the Parameters section > on the row of the specified parameter, click the Edit icon. 

2. In the Designer > enter the Parameter Name, Description, and Parameter Type. 

You can also enter the parameter attributes, including Aliases, Position, Pipeline Input, Required,

and Accepts wildcard characters ("globbing"). 
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For more information about writing content and setting values, see Write Help For Parameters .

Add syntax and parameter sets

When you create a help file without code, you need to specify the parameter sets in the command.

PowerShell HelpWriter creates a syntax statement for you from the parameter sets that you define.

Tips for adding parameter sets without code

· Before adding parameter sets, add the parameters in all parameter sets to the Parameters section

of your help file. 

· You do not need to add the Common Parameters to your help file. The Get-Help cmdlet adds

them when it displays the help topic.

· If the command supports an attribute that adds parameters to the cmdlet, you must add the

parameters that are associated with the attribute:

o SupportsPaging: First, Skip, IncludeTotalCount

o SupportsShouldProcess:  Confirm, WhatIf

o SupportsTransactions: UseTransaction

When you add one of these parameters, PowerShell HelpWriter adds the standard description for

the parameter. It is a best practice to use the standard description, but you can delete or edit it.

43

http://technet.microsoft.com/library/hh847884.aspx
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To add a parameter set

· In the Tree Navigation > right-click Parameter Sets and click Add Parameter Set.

-OR- 

· On the Home tab > click Add Parameter Set.

To add parameters to a parameter set

· In the parameter set editor > click the Add Parameter icon. Select a parameter or click Add New

Parameter. 

As you add parameters, PowerShell HelpWriter builds the syntax diagram.
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To edit the attributes of a parameter in a particular parameter set

· In the parameter set tree > click the parameter name. 

 

The values of parameter attributes (Position, Pipeline Input, Required, Accepts wildcard characters,

Dynamic) are specific to the parameter in each parameter set. You can edit an attribute in one

parameter set without affecting the attributes of the same parameter in other parameter sets.

However, the other fields (Parameter Name, Description, Parameter Type, Default Value, and Ali-

ases) are shared by all instances of the parameter. 

  When the attributes of a parameter differ among parameter sets, the instance of the parameter

in the Parameters section has the most important value. For example, if a parameter is Required
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in any parameter set, set it to Required in the Parameters section.

Complete the help topic

To add the remainder of the help topic

· Click the item and type the values in the Designer fields. 

For more information about writing content and setting values, see Write Help for Inputs , Write

Help for Outputs , Write Examples in Help , and Add Related Links . 

5.3 Write Help for Parameters

This topic explains how to write help for parameters.

About Help for Parameters

When you create a help file from the commands in a module, PowerShell HelpWriter adds the para-

meters in the command, including the parameter attributes, such as Required and Position. 

For information about adding parameters and parameter sets from scratch, see Create an Empty

Help Topic .

Key Points

· The parameter nodes under each parameter set are used to create the syntax diagram in help

topic. When you create a help file from a module, PowerShell HelpWriter creates the syntax dia-

gram from the cmdlet code. Unless the module changes, you do not need to edit the parameter

set parameter nodes.

· You do not need to add a <CommonParameters> item to the Syntax or Parameters sections of

your help file. The Get-Help cmdlet adds it automatically to all help files.

How to work with Help for Parameters

To write help for a parameter

1. In the tree navigation > in the All Parameters section, click the parameter name. 

53
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-OR-

In the Designer > in the All Parameters section, in the row for the parameter, click the Edit icon. 

The editing dialog for the parameter opens.

2. In the parameter editing dialog, enter the Description, Default Value, and Accepts wildcard

character fields (PowerShell HelpWriter cannot infer these values from the command code). Then

press Ctrl+S to save the file. 
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Here is the result in the Get-Help display.

To return to Designer view

· Click on the command name in the breadcrumb trail at the top of the pane (e.g. Disable-

PSTrace).

-OR-

· In the tree navigation > click the command name node. 
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5.3.1 Writing Help Content for Parameters

This topic provides guidelines for writing help content for parameters.

Parameter Fields

Use these guidelines to write help content for the parameters in your help file. 

Parameter Name The name of the parameter as it is spelled and capitalized in the

command code. This is a best practice, even though Windows

PowerShell is case-insensitive.

Description The parameter description describes the effect of using the para-

meter (as opposed to omitting it) and it explains requirements for

the parameters value, including format. 

For example:

"The Path parameter directs the cmdlet to search for a widget in the

specified path. By default, it searches for the widget in the current

directory. Enter a full or relative path and the file name, including

the file name extension."

"When you use the Credential parameter, the cmdlet runs with the

permissions of the credentialed user. The value is a PSCredentialGet-

Credential object, such as the object that the  cmdlet returns." 

Parameter Type Specifies the .NET type of the parameter value. PowerShell

HelpWriter gets the parameter type from the command code.

Default Value The value that the cmdlet uses when the parameter is omitted or its

value is null. Be sure to supply the default value when the parameter

is not mandatory. PowerShell HelpWriter cannot infer this value

from the command code.

Aliases Alternate names for the parameter. You do not need to list partial

names, such as the first three letters of the parameter name.

Position Specifies the required position of the parameter value when the

parameter name is omitted. For example, a value of 0 indicates that

the parameter value must be the first (or only) unnamed parameter

value in the command.

  When a help file has a parameter with a position of 0, Get-Help

automatically increments the positions of parameters in the com-

mand so that they start at position 1. 
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Pipeline input Indicates whether you can pipe parameter values to the command.

False: The cmdlet does not take parameter values from the pipeline.

True (by value):  You can pipe the parameter value to the com-

mand. The cmdlets uses the piped value, just so the value has the

specified type or is a type that Windows PowerShell can convert to

the specified type.

True (by property name): You can pipe the parameter value to the

command. However, 

the value is used only when its property name matches the name of

the parameter. For example, you can pipe the Name property of an

object to the Name parameter of the command.

Required Indicates that the parameter is mandatory. If you omit the para-

meter, Windows PowerShell prompts you for a value. If you don't

respond to the prompt, the command fails.

Accepts wildcard characters The parameter value can include "*" or "?" characters. PowerShell

HelpWriter cannot infer this value from the command code. Also

known as "globbing".

Dynamic PowerShell HelpWriter indicates when a parameter is dynamic. Dy-

namic parameters appear in a command only under certain condi-

tions. 

For example, a parameter appears only when the command runs in

a particular provider drive or only when another parameter is used

with a particular value. You can elect to include or exclude dynamic

parameters, or explain them only in a provider help topic or an

About topic.

5.4 Write Examples in Help

This topic explains how to write examples in help.

About Examples in Help

Examples might be the most important items in a help topic. Many readers learn best from seeing

the cmdlet in action and trying the steps shown in the examples. Time spent crafting instructive ex-

amples in help is always well spent. 

http://en.wikipedia.org/wiki/Glob_(programming)
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How to work with Examples in Help

To add an example

· On the Home tab > click Add Example.

-OR- 

· In the tree navigation > right-click Examples and then click Add Example.

-OR- 

· In the Designer, click the Add Example icon.

To delete an example

· In the tree navigation> right-click the example and then click Remove Example.
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-OR- 

· In the Designer > on the example row, click the Remove icon.

To write an example

· In the tree navigation > click the example title.

-OR- 

· In the Designer > click the Edit icon.

To return to Designer view

· Click on the command name in the breadcrumb trail at the top of the pane (e.g. Disable-

PSTrace).
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-OR-

· In the tree navigation > click the command name node. 

5.4.1 Writing Help Content for Examples

This topic explains how to write help content for examples.

About Help Content for Examples

Each example has Title, Introduction, Command, and Remarks sections. When you create a help file

from a module, PowerShell HelpWriter adds a default title and introduction for you.

Arrange examples in order from the simplest to the most complex. Include examples that show how

to use each of the cmdlet parameters, alone or in combination. The later examples should show how

to use the use the cmdlet in a complex, real world scenario. 

Help example fields

· Title

Enter a title that distinguishes the examples from each other. Titles allow users to refer to examples

when discussing them. When you create a new example, PowerShell HelpWriter suggests a default

title, but you can edit it.

· Introduction

Enter the command prompt. When you create a new example, PowerShell HelpWriter adds the de-

fault prompt, PS C:\>, but you can edit it to match your example. For example, you might want to

show that Windows PowerShell was started with the "Run as administrator" option:

[ADMIN]: PS C:\>

Or, show that it is running in a Windows PowerShell provider drive:

PS Cert:\>

Or, that you ran an Enter-PSSession command to an alternate computer:

[Server01]: PS C:\Users\Admin\Documents>

  If the example includes a series of commands and responses, you might want to leave the In-

troduction field blank and place the introduction in the Command field immediately preceding the

command.



51

PowerShell HelpWriter - Help Manual 
 
                                                                                                                                   © 2024 by SAPIEN Technologies Inc., all rights reserved

Using PowerShell HelpWriter

· Command

Enter the command code. To focus on the example, include full parameter names, even when they

are optional, and avoid aliases. 

You can also include the command prompt (PS C:\>) and the command output in the Command

field. For example:
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You can even include remarks in the Command field. This is especially useful for controlling spaces

between elements of the example and in commands with multiple steps.
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· Remarks

Explain what the command does and describe its results. For more complex commands, explain

why the example uses the particular strategy or format. When writing remarks, be aware that the

Get-Help cmdlet displays the content of the Remarks field after the contents of the Command

field. Other help tools might display the contents in a different order.     

Here is the Get-Help display when each element of the example is typed in a separate field.

5.5 Write Help for Inputs

This topic explains how to write help for Inputs.
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About Help for Input Types

An input or input type is a .NET type that a parameter of the cmdlet takes from the pipeline by value

(true by value). When you can pipe an object of the specified type to the cmdlet, it uses the object as

the parameter value. 

PowerShell HelpWriter gets the input types of a command from the command code. However, you

can add and delete input types as needed, and add help for the input types.

How to work with Input Types

To add an input type

· On the Home tab > click Add Input.

-OR- 

· In the tree navigation > right-click Inputs and then click Add Input.

-OR- 

· In the Designer > click the Add Input icon.

To delete an input type

· In the tree navigation > right-click an input type and click Remove Input.
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-OR- 

· In the Designer > on the input type row, click the Remove icon.

To write help for an input type

1. In the tree navigation > click the input type name.  

-OR-

· In the Designer > on the input type row, click the Edit icon.

2. Write the help content and save it (Ctrl+S). 

To return to the command page of the Designer

· In the breadcrumb trail > click the command name.
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-OR-

· In the tree navigation > click the command name. 

5.5.1 Writing Help Content for an Input Type

This topic explains how to write help content for Input Types.

About Input Types

The Inputs section of a Windows PowerShell help topic lists the .NET types that you can pipe to the

cmdlet. The types are used as the values of parameters that accept pipeline input by value, not just

by property name. The input type name is the name of the parameter value type, not the name of

the parameter. For example, if the Name parameter of the cmdlet takes a System.String value from

the pipeline by value, the input type name is System.String.

For example, you can pipe a System.String object to the Name parameter of the Get-Command

cmdlet. In this case, we pipe the "Get-ScheduledJob" string to Get-Command.

PS C:\> "Get-ScheduledJob" | Get-Command

CommandType     Name                 ModuleName
-----------     ----                 ----------
Cmdlet          Get-ScheduledJob     PSScheduledJob

If you were writing help for the Get-Command cmdlet, in the Inputs section, you would list Sys-

tem.String and explain that you can pipe System.String values to the Name parameter of Get-Com-

mand.

How to find the Inputs of a cmdlet

To find the parameters of a command that take input by value, use the following command:

(Get-Command <commandName>).ParameterSets.Parameters | 
 where ValueFromPipeline | 
 Format-List -Property ParameterType, Name

For example, the Set-LogProperties cmdlet in the PSDiagnostics module has a LogDetails para-

meter that takes a Microsoft.PowerShell.Diagnostics.LogDetails object by value.

PS C:\>(Get-Command Set-LogProperties).ParameterSets.Parameters | 
where ValueFromPipeline | 
Format-List -Property ParameterType, Name
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ParameterType : Microsoft.PowerShell.Diagnostics.LogDetails

Name          : LogDetails                                                                                                           

In this case, the input type is Microsoft.PowerShell.Diagnostics.LogDetails. In the description, ex-

plain that you can pipe an object of this type to the LogDetails parameter.

Input Type fields

Each input type has a Name, Description, and Uri field.

Name Enter the name of a type that a parameter takes by value.

Description When you pipe an object with the specified type to the cmdlet, the object, or

one of its properties, is used as the value of one of the cmdlet parameters. 

· Tell which parameter is associated with the input type and how the

value is used. 

· Explain how to get an object of that type. For example, the Get-Wid-

get cmdlet returns this type.

Uri Specifies the URL of the web page that describes the type, such as an MSDN

reference page.

How to write help for an Input Type

To write help for an input type

1. Type the values in the Input Type editor. 

2. View the result in the Get-Help display. 
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5.6 Write Help for Outputs

This topic explains how to write help for Outputs.

About Help for Output Types

An output type is the .NET type of an object that the cmdlet returns as standard output. 

PowerShell HelpWriter gets the output types of a command from the command code. However, you

can add and delete output types as needed, and add help for the output types.

How to work with Output Types

To add an output type

· On the Home tab > click Add Output.

-OR- 

· In the tree navigation > right-click Outputs and then click Add Output.

-OR- 

· In the Designer > click the Add Output icon.
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To delete an output type

· In the tree navigation > right-click the output type and then click Remove Output.

-OR- 

· In the Designer > on the output type row, click the Remove icon.

To write help for an output type

1. In the tree navigation > click the output type name.  

-OR-

· In the Designer > on the output type row, click the Edit icon.

2. Write the help content and save it (Ctrl+S). 
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To return to Designer view

· In the breadcrumb trail > click the command name.

-OR-

· In the tree navigation > click the command name. 

5.6.1 Writing Help Content for an Output Type

This topic explains how to write help content for Output Types.

About Output Types

Each output type has a Name, Description, and Uri field. 

In some cases, the cmdlet returns different types when different parameters are used in the com-

mand. For example, some cmdlets return objects only when the PassThru parameter is used.

Output Type Fields

Name Enter the.NET type of the output object.

Description Explains the content of the output object and the conditions under which the

cmdlet returns output of the specified type.

Uri Specifies the URL of the web page that describes the type, such as an MSDN

reference page.
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How to write help for an Output Type

To write help for an output type

1. Type the values in the Output Type editor. 

2. View the results in the Get-Help display. 

5.7 Write Notes in Help

This topic explains how to write notes in help.

About Notes in Help

Each help topic has a Notes section. You can use the Notes section to tell give the reader extra in-

formation, such as how to contact the author, troubleshooting tips, guidance for atypical configura-

tions, and system requirements.

  In the PSMAML XML schema, notes appear in the <maml:AlertSet> element.

How to work with Notes in Help

To add a note

· On the Home tab > click Add Note.
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-OR- 

· In the tree navigation > right-click Notes and then click Add Note.

To delete a note

· In the tree navigation > right-click an note and click Remove Note.

To write a note

1. In the tree navigation > click the note. 

2. Write the note and save it (Ctrl+S). 
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To return to the Designer view

· In the breadcrumb trail > click the command name.

-OR-

· In the tree navigation > click the command name. 

5.7.1 Writing Note Content

This topic explains how to write note content.

About Note Content

Each note has a Title and a Remark section. The title is optional and is typically omitted.

You can write all of your notes in a single Note item or create a separate note item (with optional

title) for each note. 

  Writing in a single Note item lets you control the spacing between notes.

How to write Note content

To write the note content

1. Type the values in the Note editor. 
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2. View the results in the Get-Help display. 

5.8 Add Related Links

This topic explains how to add related links to a help topic.

About Related Links

The Related Links section of a help topic consists of the names of related help topics with optional

URLs. 

Supporting Online Help

The Related Links section also implements support for online help in Windows PowerShell. The On-

line parameter of the Get-Help cmdlet (Get-Help -Online) uses the URL of the first item in the

Related Links section (if the first Related Link has a URL). 

You can also support online help by adding the HelpUri attribute to any command type. If a com-

mand has both a HelpUri attribute and a URL in the first related link, the value of the URL in the first

related link takes precedence over the value of the HelpUri attribute. For detailed instructions on

supporting online help, including specific instructions for implementing online help in each com-

mand type, see Supporting Online Help.

https://docs.microsoft.com/en-us/powershell/scripting/developer/module/supporting-online-help?view=powershell-7
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When you create a help topic from a module and the existing help includes an online link, Power-

Shell HelpWriter adds the online link to the starter help file. You can also add and delete online links

from any help topic. The online link must be the first item in the Related Links section of the help

topic and it must have a URL value that begins with http or https.

How to work with Related Links

To add a related link

· On the Home tab > click Add Link.

-OR- 

· In the Designer > click the Add Link icon.

To add an online help link

· In the Designer > click the Add Online Link icon.

  Because each help topic can have only one online link, the Add Online Link icon is disabled

when the help topic has an online link.

To delete a related link

· In the Designer > on the Related Link row, click the Remove icon.
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5.8.1 Writing Help for a Related Link

This topic explains how to write help for a related link.

About Related Link Help

The online link must be the first link in the related links section. The URL value must begin with http

or https. You can have only one online link in each help topic. 

Online Help Related Link

When you add an online link, PowerShell HelpWriter adds the "Online version:" text for you. 

To change the default URL to the URL of the online version of the help topic

· Click in the URL field > then type the values and save (Ctrl+S).

  After you add an online link the Add Online Link icon is disabled.

Standard Related Link

To edit a standard related link

· In the Links window > edit the link name and, optionally, the URL.

  If you are not supporting online help for the cmdlet, do not enter a URL in the first related link.

Otherwise, Get-Help assumes that it is an online version link, regardless of the link name.
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5.9 Edit Help Topics as XML

You can view and edit your help files in any text or XML editor, or use the PowerShell HelpWriter XML

Editor. The PowerShell HelpWriter XML Editor can edit any text or XML file, including help files that you

create in PowerShell HelpWriter and other tools. 

5.9.1 Switching Between the Designer and Editor

While writing or editing, you can switch back and forth from editing in the Designer to editing in the

XML Editor. 

  When you switch from the Designer to the XML Editor (and back), the current file is saved,

closed, and reopened to prevent overwriting changes made in the previous view. 

To switch from the Designer and XML Editor

1. In PowerShell HelpWriter, create or open a help file. 

2. On the ribbon, click Edit in XML. 
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The file closes and reopens in the XML Editor. This isn't just a display. You can edit the XML, too.

To switch from the XML Editor to the Designer

· On the ribbon > click Edit in Designer.

5.9.2 Opening XML Files in the XML Editor

You can use the XML editor in PowerShell HelpWriter to edit any XML file. 

  If you open an XML file that is not a Windows PowerShell help file, PowerShell HelpWriter auto-

matically opens it in the XML Editor.
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How to open XML files in the Editor

To open an XML file in the XML Editor

· In PowerShell HelpWriter > click File > Open (Ctrl+O) > navigate to a file, and then click Open.

-OR- 

· In File Explorer > right-click any XML file, and then click Edit with PowerShell HelpWriter.

For example, these HelpInfo.xml files for Updatable Help open directly in the XML Editor.

The file opens in XML Editor.

5.9.3 Formatting XML Files

PowerShell HelpWriter generates well-formatted ("pretty print") XML and automatically formats XML files

that you open.

How to Format and Reformat XML Files

You can use the PowerShell HelpWriter editor to format or reformat any XML file.



70

PowerShell HelpWriter - Help Manual 
 
                                                                                                                                   © 2024 by SAPIEN Technologies Inc., all rights reserved

Using PowerShell HelpWriter

To format an XML file

1. Open the file in PowerShell HelpWriter.  

  Help files automatically open in the designer. Other XML files open in the XML editor.

To switch a help file to the XML editor, if necessary, click Edit in XML.

2. Click Save. 

When you save, PowerShell HelpWriter writes the formatted XML to your file.

For example, this generated XML file, shown in Notepad with word wrap, has all elements on a

single line. 

When you open the file in PowerShell HelpWriter, it automatically formats the XML. 

When you save, PowerShell HelpWriter writes the formatted XML to your file. Here's the result in

Notepad.
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To reformat an XML file

If you edit the XML and need to reformat it:

· On the XML tab, click Format Document.

`

5.9.4 Using Empty or Closing Tags

This topic explains how to use empty or closing tags.

About XML Element Tags

PowerShell HelpWriter creates separate opening and closing tags for all elements. 

For example: <maml:para></maml:para>

However, when an XML element is empty, you can replace the opening and closing tags with an

empty element tag. 

For example: <maml:para/>

  Both formats are considered to be well-formed XML.
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Determining an Empty Tag Format

To determine the empty tag format

1. On the Home tab > click Options. 

2. Check or clear the Show closing tags option.

3. To make the change effective > on the XML tab, click Format Document.
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6 Getting Help

This help manual has been designed to provide all the information you will need for using PowerShell

HelpWriter. In addition to the information in this guide, you can also ask questions in the online support

forums .

  View PowerShell HelpWriter product feature demonstrations and release details on our blog.

Accessing the help manual 

To view the help manual online

· In PowerShell HelpWriter, on the Help ribbon > in the Product Support section, click Product

Manual. 

  The SAPIEN Information Center provides direct access to all of the SAPIEN product manuals.

User forums and support

Use the SAPIEN forums to get help with PowerShell HelpWriter, submit feature requests, and more.

· PowerShell HelpWriter forum

· Scripting support forums

· All SAPIEN support options

  To report a problem in the PowerShell HelpWriter forum, you will need to provide your SAPIEN

product and OS version information .

How to copy version information

To report a problem in the PowerShell HelpWriter forum, you will need to include the product ver-

sion and build, and also your OS version and build—and indicate 32 or 64-bit for each. 

To copy the required version information

1. Click the About button in the top-right of the PowerShell HelpWriter workspace. 

2. In the About PowerShell HelpWriter window, select Copy Version Info.

3. Paste the version information into your PowerShell HelpWriter forum post. 
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https://www.sapien.com/blog/topics/powershell-helpwriter/
https://info.sapien.com/manuals/
https://www.sapien.com/forums/viewforum.php?f=28
https://www.sapien.com/forums/viewforum.php?f=6
https://www.sapien.com/support
https://www.sapien.com/forums/viewforum.php?f=28
https://www.sapien.com/forums/viewforum.php?f=28
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7 Reference

This section provides an overview of the SAPIEN Updates tool, and lists the keyboard shortcuts available

in PowerShell HelpWriter.

7.1 SAPIEN Updates

We are continually updating our software, both to remove bugs and to add and improve product fea-

tures. We recommend always staying current with the most recent versions to ensure that you are taking

advantage of the latest features, functionality, and product stability. 

Every SAPIEN product has a built-in update tool—SAPIEN Updates—which will check for updates on all

current activations and unexpired trial versions of our products. Available product updates are indicated

in the SAPIEN Updates tool and also in the Notifications dialog  (see below).

SAPIEN Notifications

SAPIEN products provide automatic notifications when there is a software update available, or when

your maintenance is about to expire. Notifications are indicated by a 'flag' icon in the top-right of

the program window:

How to view SAPIEN notifications

· Click the notification flag icon above the ribbon to open the Notifications dialog:

· If a product update is available, click the update notification to open the SAPIEN Updates tool.

  Click the X button to dismiss individual notifications or select Dismiss All. Dismissed notifica-

tions will not be shown again.

SAPIEN Updates - Tool Overview

The SAPIEN Updates tool indicates when an update is available for any SAPIEN program installed on

your computer. 
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  To minimize the impact on your system, the tool does not run during Windows startup or con-

tinuously in the system tray.

How to access the SAPIEN Updates tool

· On the Help or Tools ribbon > click Check Now or Check For Updates (Updates section).

-OR-

· Click the notification icon  above the ribbon > then in the Notifications dialog, click the up-

date notification.

SAPIEN Updates Tool

SAPIEN Updates Tool

74
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SAPIEN Updates - Options

Check for updates now Immediately checks to see if additional product

updates are available.

View Downloads folder Displays the Downloads folder in File Explorer.

View update history Displays the history of all downloaded and in-

stalled product updates.

Available Displays a selectable list of available product

updates.

  Select one or more products to Download

or Download and Install.

Download and Install Downloads and installs the updates for the

product(s) selected in the Available updates list.

Download only Downloads the updates for the product(s) selec-

ted in the Available updates list.

Close Closes the SAPIEN Updates tool.

Notes Displays a brief synopsis of what was changed,

added, or fixed for the products selected in the

Available window.

  The build history for all SAPIEN products is

available here.

Update On-Demand

You don't need to wait to be notified when an update is available; you can check for updates at any

time. This is particularly useful if you've heard about a new update and want to install it immediately,

or if you are ready to start a new project and want to complete all updates before you begin. 

How to check for updates on-demand

· On the Help or Tools ribbon > select Check Now or Check For Updates to open the SAPIEN

Updates tool.

  These instructions may vary between SAPIEN products.

https://www.sapien.com/software/version_history
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· In the SAPIEN Updates tool, select Check for updates now:

The latest product updates are displayed in the SAPIEN Updates Available window.

Security and Permissions

Installing updates to programs in a Program Files directory requires the permissions of a member of

the Administrators group on the computer. When you click Download and Install in the SAPIEN Up-

dates tool, or if you install after downloading, you will be prompted for administrator credentials.

The update tool requires a functioning internet connection and unimpeded access through your in-

ternet firewall. For some installations, you might need to create a firewall rule to allow access or

make some accommodations. 

7.2 Keyboard Shortcuts

This section covers the keyboard shortcuts available in PowerShell HelpWriter.
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General Commands

Copy Ctrl + C

Paste Ctrl + V

Cut Ctrl + X

Select All Ctrl + A

Undo Ctrl + Z

Redo Ctrl + Y

New Help File from Module Ctrl + N

New Help Project (Empty) Ctrl + Shift + N

New Help File Ctrl + Alt + N

New About File Ctrl + Shift + Alt + N

Open File Ctrl + O

Open Project Ctrl + Shift + O

Save Ctrl + S

Print Ctrl + P

Switch to Next Document Tab Ctrl + Tab

Switch to Prev Document Tab Ctrl + Shift + Tab

Minimize Ribbon Ctrl + F1

Access Ribbon Key Shortcuts Alt or F12

XML Commands

Format Document Ctrl + Shift + J

Validate XML F8
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Navigation Commands

Go to Previous Command Shift + F4

Go to Previous Category Shift + F6

Go to Previous Help Item Shift + F3

Go to Next Command F4

Go to Next Category F6

Go to Next Help Item F3

Navigate Backwards Ctrl + Shift + -

Navigate Forwards Ctrl + Shift + +

Editor Commands

Go To Line Ctrl + G

Find Ctrl + F

Find Next F3

Find Previous Shift + F3

Comment Line Ctrl + Q

Un-Comment Line Ctrl + Shift + Q

Replace Ctrl + H

Return Commands

Insert Line Break Enter

Insert Line Break Shift + Enter

Open Line Above Ctrl + Enter

Open Line Below Ctrl + Shift + Enter

Delete / Backspace Commands

Delete Del

Delete Line Ctrl + Shift + L

Delete To Next Word Ctrl + Del
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Backspace Backspace

Backspace Shift + Backspace

Backspace To Previous Word Ctrl + Backspace

Clipboard / Undo Commands

Copy To Clipboard Ctrl + C

Copy To Clipboard Ctrl + Ins

Cut Line To Clipboard Ctrl + L

Cut To Clipboard Ctrl + X

Cut To Clipboard Shift + Del

Paste From Clipboard Ctrl + V

Paste From Clipboard Shift + Ins

Undo Ctrl + Z

Redo Ctrl + Y

Redo Ctrl + Shift + Z

Movement Commands

Move Down Down

Move Up Up

Move Left Left

Move Right Right

Move To Previous Word Ctrl + Left

Move To Next Word Ctrl + Right

Move To Line Start Home

Move To Line End End

Move To Document Start Ctrl + Home

Move To Document End Ctrl + End

Move Page Up Page Up

Move Page Down Page Down

Move To Visible Top Ctrl + Page Up
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Move To Visible Bottom Ctrl + Page Down

Move To Matching Bracket Ctrl + ]

Move To Next Modified Line Ctrl + Shift + Down

Move To Previous Modified Line Ctrl + Shift + Up

Go To Next Occurance Ctrl + Shift + Alt + Down

Go To Previous Occurance Ctrl + Shift + Alt + Up

Go To Last Edit Position Ctrl + E

Go To Function Declaration Ctrl + F12

Go To Next Function Shift + F12

Go To Prev Function Ctrl + Shift + F12

Scroll Commands

Scroll Down Ctrl + Down

Scroll Up Ctrl + Up

Indenting Commands

Indent Tab

Indent Alt + Right

Outdent Shift + Tab

Outdent Alt + Left

Selection Commands

Select Down Shift + Down

Select Up Shift + Up

Select Left Shift + Left

Select Right Shift + Right

Select To Previous Word Ctrl + Shift + Left

Select To Next Word Ctrl + Shift + Right

Select To Line Start Shift + Home

Select To Line End Shift + End
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Select To Document Start Ctrl + Shift + Home

Select To Document End Ctrl + Shift + End

Select Page Up Shift + Page Up

Select Page Down Shift + Page Down

Select To Visible Top Ctrl + Shift + Page Up

Select To Visible Bottom Ctrl + Shift + Page Down

Select All Ctrl + A

Select Word Ctrl + W

Cut Word Ctrl + Shift + W

Select To Matching Bracket Ctrl + Shift + ]

Select Block Down Shift + Alt + Down

Select Block Up Shift + Alt + Up

Select Block Left Shift + Alt + Left

Select Block Right Shift + Alt + Right

Select Block To Previous Word Ctrl + Shift + Alt + Left

Select Block To Next Word Ctrl + Shift + Alt + Right

PrimalSense™ Commands

PrimalSense™ Complete Word Ctrl + Space

Other Commands

Change Character Casing (to uppercase) Ctrl + Shift + U

Change Character Casing (to lowercase) Ctrl + U

Collapse Selection Escape

Toggle Overwrite Mode Insert

Transpose Characters Ctrl + T

Transpose Words Ctrl + Shift + T

Transpose Lines Ctrl + Shift + Alt + T



83

PowerShell HelpWriter - Help Manual 
 
                                                                                                                                   © 2024 by SAPIEN Technologies Inc., all rights reserved

Reference

Go-To Panel Commands

Navigation Ctrl + Alt + P, N

Output Ctrl + Alt + P, O

Preview Ctrl + Alt + P, V

Project Ctrl + Alt + P, J

Properties Ctrl + Alt + P, P

Editor / Document Ctrl + Alt + P, E

7.3 Appendices

Appendices for PowerShell HelpWriter Help Manual

Appendix A: Manual and Product Version

Appendix B: Icon License Attribution

7.3.1 Appendix A: Manual Version

Appendix A

Manual Version

This help manual is in the process of being updated. Some features and images in this manual version

may not reflect the current product functionality. 

Blog articles

For the latest product tips and feature demonstrations, check out the PowerShell HelpWriter articles on

the SAPIEN blog.
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Release details

To view a brief description of what was changed, added, or fixed in the most recent PowerShell

HelpWriter builds, view the product version history.

Need more help?

Please direct your product related questions to the PowerShell HelpWriter support forum, and your

scripting questions to the appropriate Scripting Answers forum.

7.3.2 Appendix B: Icon License Attribution

Appendix B

Icon License Attribution

Some of the icons used in this manual were made by Freepik at www.flaticon.com and are licensed un-

der CC BY 3.0:        

https://www.sapien.com/software/version_history/PowerShell_HelpWriter_2024
https://www.sapien.com/forums/viewforum.php?f=28
https://www.sapien.com/forums/viewforum.php?f=6
https://www.flaticon.com/authors/freepik
http://www.flaticon.com
http://creativecommons.org/licenses/by/3.0/
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